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IMPORTANT NOTICE 

All information in this document, such as descriptions, specifications, drawings, recommendations and other 
statements, is believed to be correct and reliable. Although given in good faith, the accuracy and/or completeness 
of such data is not guaranteed or legally binding on Parker Meggitt (Meggitt SA) and we reserve the right to alter 
any part of this document/publication without prior notice. Before acquiring and/or using this product, you should 

evaluate it and determine if it is suitable for your intended application. You should also check our website at 
www.meggittsensing.com/energy to ensure that the latest versions of documentation are being used. For example, 
data sheets, certificates, product drawings, user manuals, service bulletins and/or other instructions affecting the 

product. 

Unless expressly agreed in writing with Parker Meggitt, you assume all risks and liability associated with use of the 
product. Any recommendations and advice given without charge, whilst given in good faith, are not legally binding. 

We take no responsibility for any statements related to the product which are not contained in a current 
Parker Meggitt publication, nor for any statements contained in extracts, summaries, translations or any other 

documents not authored and produced by us. 

The certifications and warranties applicable to the products supplied by Parker Meggitt are valid only for new 
products purchased directly from us or an authorized distributor. 

Parker Meggitt reserves the right to alter any part of this publication without prior notice. 

 

 
EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the European 
Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or 
use of any information contained in this document complies with all relevant export control regulations. ECN N /A. 

 

 
COPYRIGHT 

Copyright © 2025 Parker Meggitt. All rights reserved. 
Published and printed by Parker Meggitt (Meggitt SA) in Fribourg, Switzerland. 

The names of actual companies and products mentioned herein may be the trademarks of their respective owners. 

This information shall not be used, duplicated or disclosed, in whole or in part, without the express written 
permission of Parker Meggitt (Meggitt SA). 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Parker Meggitt (Meggitt SA). 
It is applicable to all VibroSight-based condition monitoring systems using the versions of software described by 
this document, namely: 

• VibroSight software version 7.7.0 
(part numbers (PNRs) software license: 608-001-000-001/Codes 
and software: 609-010-000-001 on physical media (USB device (flash drive/key))). 

This document contains information about changes to the software since the previously released version 
(VibroSight 7.6.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire machinery protection system (MPS) and/or 
condition monitoring system (CMS), refer to the following Parker Meggitt documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-228A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-237A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay module data sheet 
        (document reference 268-125) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring modules data sheet 
        (document reference 660-020-010-213A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 7.6.0 (document reference 660-010-013-239A) 

• VibroSight 7.5.0 (document reference 660-010-013-238A) 

• VibroSight 7.4.0 (document reference 660-010-013-237A) 
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• VibroSight 7.3.0 (document reference 660-010-013-236A) 

• VibroSight 7.2.0 (document reference 660-010-013-235A) 

• VibroSight 7.1.0 (document reference 660-010-013-234A) 

• VibroSight 7.0.0 (document reference 660-010-013-233A) 

• VibroSight 6.1.0 (document reference 660-010-013-232A) 

• VibroSight 6.0.0 (document reference 660-010-013-231A) 

• VibroSight 5.1.0 (document reference 660-010-013-230A) 

• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 

• VibroSight 4.0.0 (document reference 660-010-013-227A) 

• VibroSight 3.8.0 (document reference 660-010-013-226A) 

• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 

• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 
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• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 

• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E). 

 

Use of the release notes 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Parker Meggitt (Meggitt SA) products that can be used with the VibroSight® 
software, the following terminology is used in this document: 

 

• VM600Mk2/VM600 modules/card(s) – to refer to VibroSight compatible cards that are installed in a 
VM600Mk2/VM600 rack (that is, the first generation of VM600 systems). 

The currently available VM600Mk2/VM600 modules/cards that are designed for operation with the VibroSight 
software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Note: It is important to note that VibroSight Configurator is still used for the configuration of these 
VM600Mk2/VM600 modules/cards/systems. 

Where XMx16 is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T 
cards, unless otherwise stated. 

Where CPUx is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless otherwise 
stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modules that are installed in a VM600Mk2 rack (that is, 
the second generation of VM600 systems). 

The currently available VM600Mk2 modules that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module (standard and SIL versions), the 
RLC16Mk2 relay module and the CPUMMk2 + IOCNMk2 rack controller and communications interface module. 

Note: It is important to note that VibroSight Protect is used for the configuration of VM600Mk2 modules/systems. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 and 
VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 

Where VSV30x is used in this document, it refers to VSV301 and VSV300 modules, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 7.7.0 is a minor level release and a new license key file is not required 
for updates and upgrades from VibroSight 7.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 
For further information on licensing or to obtain a new VibroSight license key file, contact Parker Meggitt 
(Meggitt SA) customer support. See 7 Customer support. 

 

 

2 Features 

General 

2.1 New filtering options in Waveform and Orbit plots 
The Waveform and Orbit plots now support enhanced data filtering options, providing users with greater flexibility 
when visualizing vibration signals. 

 

A new Filtering tab has been added to the Plot Properties dialog, allowing users to define and apply custom filters 
directly within the plot. Filters can be applied to all data items displayed in the plot and configured using one of two 
modes: Single frequency filter or Frequency band filter. 

 

1. Single frequency filter 

This mode allows the user to specify a single frequency to isolate in the signal. 

The frequency can be defined in either Hertz (Hz) or Orders. 

Useful for highlighting a specific frequency component of interest. 
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Figure 1: VibroSight Vision single frequency filter screenshot 

 

2. Frequency band filter 

This mode enables the configuration of a band-pass filter by specifying both high-pass and low-pass cutoff 
frequencies. 

Each cutoff frequency can be defined independently in Hz or Orders. 

Users can enable or disable the high-pass and low-pass components as needed. 

A visual frequency response diagram helps illustrate the effect of the selected band configuration. 
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Figure 2: VibroSight Vision Frequency Band Filter screenshot 

 

These filters make it easier to focus on specific frequency ranges or exclude unwanted components during 
waveform and orbit analysis, enhancing the clarity and relevance of displayed data. 

 

Note: This functionality is currently available for Waveform and Orbit plots. Future versions of VibroSight will extend 
filtering support to the Corbit and Long Waveform plots. 

 

 

2.2 Dual-channel reverse rotation processing for VM600Mk2 MPC4Mk2 modules 

A new dual-channel reverse rotation processing block has been added to VibroSight Protect and 
VibroSight Capture, extending the software’s support for reverse rotation detection using two tachometers. This 
processing is now available for the standard version of the VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and 
condition monitoring module (that is, reverse rotation processing is not supported by the SIL version of the 
module). 

 

VibroSight Protect – input channel configuration 

The dual channel reverse rotation processing can be configured using the input channel configuration wizard, now 
available under the Tachometers sensor family: 

• A new processing option labeled Reverse rotation has been added to the dual channel processings catalog. 
• Users can assign the leading and lagging transducers from auxiliary speed channels. 
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Figure 3: VibroSight Protect reverse rotation processing input channel configuration screenshots 
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VibroSight Protect – processing configuration 

The Processing pane allows full configuration of output measurement names, units, and additional properties: 

• Forward speed. 
• Reverse speed. 
• Reverse peak speed. 

o Tooltip: Holds the maximum speed read in the reverse direction. Reset using the Dashboard peak hold 
reset button. 

• Number of reverse rotations. 
o Tooltip: *A cumulative count of the number of rotations in the reverse direction. Reset using the 

Dashboard peak hold reset button.* 

 

 
Figure 4: VibroSight Protect reverse rotation processing processing configuration screenshot 

 

 

VibroSight Protect – Dashboard integration 

Each configured dual channel reverse rotation block includes a “Peak hold reset” button on the Dashboard, which 
resets: 

• Reverse peak speed. 
• Number of reverse rotations. 

 

The command is sent directly to the VM600Mk2 MPC4Mk2 module to trigger the reset. 
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VibroSight Capture – integration with machine train components 

In VibroSight Capture, the new processing can be connected to the following machine train components: 

• Shaft projection. 
• Shaft notch. 
• Toothed wheel. 

 

This integration allows accurate modeling and visualization of reverse rotation monitoring across compatible 
mechanical configurations. 

 

 

2.3 Modbus TCP server configuration support in VibroSight Capture 

The VibroSight Capture module now supports configuration of a Modbus TCP server, enabling integration with 
third-party systems via the widely used Modbus protocol. This enhancement aligns the VibroSight Capture module 
with functionality previously available in VibroSight Configurator, offering consistent and flexible server setup 
across platforms. 

 

New Server creation 

Users can create one or multiple Modbus TCP servers under the "Data > Sharing" tab. While multiple servers are 
supported, only a single server is required for most use cases. 

 

 
Figure 5: VibroSight Capture Modbus TCP server creation screenshot 



 

Document reference VIBROSIGHT-RN/E (660-010-013-240A) 
Version 40 – 28.03.2025 

RELEASE NOTES 
VibroSight® 7.7.0 

17 / 84 
 

Modbus Server configuration pane 

The Modbus server configuration pane includes the following general settings: 

• Enabled. 
• Tag name and Description. 
• Output interface (e.g., Any_Tcp502). 
• Slave ID. 
• Update rate and Data validity. 

o Tooltip for Data validity: "If the Modbus server is requested data whose validity timeout has expired, 
Modbus exception code 04 SLAVE DEVICE FAILURE will be returned." 

• Default output units and default phase qualifier. 

 

 
Figure 6: VibroSight Capture Modbus TCP server configuration screenshot 

 

Published measurements table 

A list of published measurements can be populated using the "Add..." button. Each entry includes the following 
attributes: 

• Address (0-based). 
• Measurement. 
• Unit. 
• Qualifier. 
• Data type. 
• Byte ordering. 
• Min fieldbus value. 
• Min engineering value. 
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• Max fieldbus value. 
• Max engineering value. 
• Decode factor. 
• Decode offset. 

 

Additional features: 

• When new registers are added, addresses are assigned automatically starting from the next available address. 
• Addresses can be reassigned according to the row order, starting from address 0. 

 

The interface allows measurements to be filtered by Machinery view or System view, and optionally limited to non-
defaults only. 

 

This new functionality enables users to publish vibration and condition monitoring data directly from Capture to 
Modbus-compatible supervisory systems such as SCADA, DCS, and HMI platforms. 

 

Note: This feature covers Modbus TCP only. Support for Modbus Serial will be added in the future – if there is 
enough customer demand for it. 

 

 

2.4 Improved modeling of redundant axial position sensors in VibroSight Capture 

The VibroSight Capture module now supports connecting multiple “Shaft axial position (collar)” processings to a 
single collar component in the machinery train diagram. This enhancement improves the accuracy and realism of 
machine configuration, particularly in systems equipped with redundant axial position sensors. 

With this update: 

• Users can now connect multiple axial position processings (single or dual) to the same collar. 
• The number of connected sensors is clearly displayed on the collar component in the machine train diagram, 

improving visibility and ease of configuration. 

This feature enhances modeling flexibility and ensures the digital representation of the machine aligns more closely 
with real-world instrumentation. 
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Figure 7: VibroSight Capture Shaft axial position (collar) screenshot 

 

Previously, it was only possible to connect one single or dual "Shaft axial position (collar)" processing to each 
collar. As a workaround, users had to add multiple collar components—one for each sensor—which did not reflect 
the actual machine configuration and introduced unnecessary complexity in the model. 

 

 

2.5 VibroSight Protect and VibroSight Capture user interface improvement 

In the VibroSight Protect and VibroSight Capture user interfaces, the leftmost and rightmost panes on most 
tabs/pages now feature independently adjustable widths. 

For example, in VibroSight Protect, on the Configure tab/page, this includes the module feature selection pane 
(Channels, Logical functions, Relays, etc.) on the left, and the System and History control panes on the right. 

For example, in VibroSight Capture, on the Machinery tab/page, this includes the Machine train properties pane on 
the left, and the Machines and History control panes on the right. 

This new feature allows the widths of these panes to be increased (or decreased) as required, for example, to 
make it easier to read longer tag names, and to otherwise optimize the usage of display area as a function of the 
type/size of screen available and/or user preferences. 
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2.6 VibroSight Protect, VM600Mk2 MPC4Mk2 + IOC4Mk2 module custom dynamic processing and 
new time domain measurements 

In VibroSight Protect, for VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules, 
when using custom dynamic processing on dynamic input channels, it is now possible to configure three new types 
of time domain measurement as part of the processing for the channel (in addition to the existing support for time 
domain measurements). 

Please note that using any of the new types of time domain measurement – Amplitude at angle, Amplitude range at 
angle and RMS at angle – requires that the Acquisition mode for the channel is configured as order tracking and 
that the Reference speed is specified (both on the Processing tab). 

 

In more detail, the three new types of time domain measurement are: 

• Amplitude at angle 

A measurement of the average amplitude over an averaging range specified using a trigger angle and 
averaging range (in degrees). For example, a measurement could be specified as the average amplitude 
between 90° and 100°. 

• Amplitude range at angle 

A measurement of the amplitude range over an averaging range specified using a trigger angle and averaging 
range (in degrees). For example, a measurement could be specified as the amplitude range between 90° and 
100°. 

• RMS at angle 

A measurement of the RMS amplitude over an averaging range specified using a trigger angle and averaging 
range (in degrees). For example, a measurement could be specified as the RMS amplitude between 90° and 
100°. 

 

Adding Amplitude at angle, Amplitude range at angle and/or RMS at angle measurements to the custom dynamic 
processing block allows a wider range of new applications to be covered, notably rod-drop monitoring. 

For example, Amplitude at angle, Amplitude range at angle and/or RMS at angle measurements can easily be used 
by configuring a dynamic channel as follows: 

• Processing type: Single, Sensor family: Other sensors, Processing function: Custom dynamic, … 

• Processing, Acquisition: Order tracking, Processing, Reference speed: …, Processing, Measurements: adding 
Time domain measurements and configuring the Measurement type(s) as Amplitude at angle, Amplitude range 
at angle and/or RMS at angle, as required. 
 

Previously, VibroSight Protect and VM600Mk2 MPC4Mk2 + IOC4Mk2 module custom dynamic processing only 
supported the following Time domain measurement types: True RMS, True Peak, True Peak Peak and True 
Average. 
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2.7 VibroSight Protect, VibroSight Capture, VM600Mk2 MPC4Mk2 + IOC4Mk2 module “gap” 
measurements 

In VibroSight Protect and VibroSight Capture, for VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition 
monitoring modules, when using processing blocks that feature a gap or DC measurement, it is now possible to 
configure the gap or DC measurement in electrical units, that is, in terms of “gap current” or “gap voltage”, 
depending on the electrical output signal from the sensor / measurement chain.  

This is in addition to the existing support for gap or DC measurement as a gap (for Shaft relative vibration 
processing) or sensor sensitivity engineering physical quantity (for other processings), that is, in terms of an initial 
value (that is, and offset) and a value range that can be inverted, as required. 

 

 

2.8 VibroSight Protect, VM600Mk2 MPC4Mk2 + IOC4Mk2 module custom dynamic processing and 
DC measurements 

In VibroSight Protect, for VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules, 
when using custom dynamic processing on dynamic input channels, it is now possible to configure DC 
measurements as part of the processing for the channel (in addition to the existing support for frequency domain 
measurements and time domain measurements). 

Please note that using DC measurements requires that the Signal coupling for the channel is configured as AC+DC 
(on the General tab). 

 

Adding DC measurements to the custom dynamic processing block allows a wider range of sensors to be used, 
thereby increasing system flexibility. 

For example, a pressure sensor that provides both static (DC) and dynamic (AC) outputs can now easily be used 
by configuring a dynamic channel as follows: 

• Processing type: Single, Sensor family: Other sensors, Processing function: Custom dynamic, … 

• General, Signal coupling: AC+DC, Processing, Measurements: adding Frequency domain, Time domain and/or 
DC measurements, as required. 

 

Previously, VibroSight Protect and VM600Mk2 MPC4Mk2 + IOC4Mk2 module custom dynamic processing only 
supported Frequency domain measurements and Time domain measurements. 
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2.9 VibroSight Capture and data logging step-based rates 

In VibroSight Capture, when configuring data logging rules for a VibroSight database, the data Logging rate in 
terms of the Step based rate, which is specified in % FDR (that is, % of full deflection), can now be configured with 
values between >0 and 100%. 

However, please note that only values greater than 0% are allowed (that is, 0% is not allowed) and the value can 
also be a decimal (that is, integer not required). For example, 0.001% and 5.77% are valid values. 

Previously, it was only possible to configure the Step based rate with values between 1 and 100% (that is, >1%). 

 

 

2.10 VibroSight Capture and VM600Mk2/VM600 XMV16 + XIO16T module redundant 
communications 

Since VibroSight 7.5, VibroSight Capture has been able to configure and operate VM600Mk2/VM600 XMV16 + 
XIO16T extended condition monitoring modules for vibration – making it possible to manage a mixed array of 
VM600Mk2 MPC4Mk2 modules and VM600Mk2 /VM600 XMV16 and/or XMVS16 modules within a single VibroSight 
Capture configuration. This streamlines system data management processes and enables data logging into a 
unified VibroSight database using just one VibroSight Server instance. 

 

In VibroSight Capture, when configuring a VM600Mk2/VM600 XMV16 module, it is now possible to configure two 
IP addresses for the module in order enable redundant communications with it. (Whereas previously, it was 
necessary to use VibroSight Configurator in order to configure two IP addresses for a VM600Mk2/VM600 XMV16 
module.) 

To configure two IP addresses for a VM600Mk2/VM600 XMV16 module: 

• In VibroSight Capture, on the Configure tab/page, select the System view (top right) to display the 
VM600Mk2/VM600 rack/system (top). 

• On the VM600Mk2/VM600 rack/system (top), select the VM600Mk2/VM600 XMV16 module, then in the General 
tab (below), use the Network settings controls to configure the two IP addresses for the module (IP address 1 
and IP address 2). 

Note: The Mode control must be set to Manual IP address in order for IP address 1 and IP address 2 to be 
changed. When the Mode control is set to Automatic discovery from serial number, both IP addresses are retrieved 
from the module and displayed as read-only values. 
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2.11 VibroSight Capture, VM600Mk2 MPC4Mk2 + IOC4Mk2 module condition monitoring and order 
tracking frequency span 

In VibroSight Capture, for VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules, 
when using condition monitoring on dynamic input channels configured with order tracking, it is now possible to 
configure the frequency span up to DC to 200 orders (in addition to the existing frequency span ranges from DC to 
3.125 orders, up to DC to 100 orders). 

Please note that using frequency span measurements requires that the Acquisition mode for the channel is 
configured as order tracking and that the Reference speed is specified (both on the Processing tab). 

 

Increasing the maximum frequency span up to DC to 200 orders allows for wider spectra (both Spectrum and Full 
Spectrum plots) and more detailed analysis, in order allow wider range of machinery conditions to be diagnosed, 
and is particularly applicable to slower speed machinery such as hydro turbines. 

 

 

2.12 VibroSight Capture and VM600Mk2/VM600 XMV16 + XIO16T module bearing absolute 
vibration with accelerometers 

Since VibroSight 7.5, VibroSight Capture has been able to configure and operate VM600Mk2/VM600 XMV16 + 
XIO16T extended condition monitoring modules for vibration – making it possible to manage a mixed array of 
VM600Mk2 MPC4Mk2 modules and VM600Mk2 /VM600 XMV16 and/or XMVS16 modules within a single VibroSight 
Capture configuration. This streamlines system data management processes and enables data logging into a 
unified VibroSight database using just one VibroSight Server instance. 

 

In VibroSight Capture, when configuring a VM600Mk2/VM600 XMV16 module, it is now possible to configure bearing 
absolute vibration processing with an accelerometer as the sensor. (Whereas previously in VibroSight Capture, it 
was only possible to configure bearing absolute vibration processing with a velocity sensor or velocimeter as the 
sensor.) 

To configure bearing absolute vibration processing with an accelerometer as the sensor for a VM600Mk2/VM600 
XMV16 module: 

• In VibroSight Capture, on the Configure tab/page, select the System view (top right) to display the 
VM600Mk2/VM600 rack/system (top). 

• On the VM600Mk2/VM600 rack/system (top), select the VM600Mk2/VM600 XMV16 module, then in the Channels 
pane (left), click a channel to select it, then configure it as follows: 

o Processing type: Single, Sensor family: Accelerometers, Processing function: Bearing absolute 
vibration, … 

Note: In general, bearing absolute vibration functionality and measurements are the same whether an 
accelerometer or a velocity sensor or velocimeter is used as the sensor. The main difference is the physical 
quantity used for the measurements: acceleration for accelerometers, and velocity for velocity sensors or 
velocimeters. 
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2.13 VibroSight Protect and VM600Mk2 MPC4Mk2 + IOC4Mk2 module CRC checksums 

In VibroSight Protect, for VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules, it 
is now possible to display a cyclic redundancy check (CRC) checksum value that corresponds to the machinery 
protection functionality configured for and running on the module. 

NOTE: Module CRC checksum values are intended to allow users to more easily 
identify/verify and manage the versions of machinery protection configuration 
running on VM600Mk2 MPC4Mk2 + IOC4Mk2 modules. 

 

To display the CRC checksum for a module, in VibroSight Protect, click File > CRC checksums… and a System 
window will be displayed showing the CRC checksum values for all of the configured modules in the rack/system. 

Further, in this System window, when the pointer is held over the tooltip icon corresponding to a particular module, 
a message will be displayed to indicate if the machinery protection configuration running on the module 
corresponds to the machinery protection configuration that is currently open in VibroSight Protect (that is, whether 
the CRC checksum values on the module and in VibroSight Protect are the same or not). 

 

Please note that the module CRC checksum values displayed in VibroSight Protect in this way are the same as the 
CRC checksum values also available from VibroSight system Manager. 
(In VibroSight system Manager, when a device is selected in the System explorer (left), the CRC checksum values 
is available in the main window (centre), under General information, Machinery protection configuration, where it is 
listed as a CRC32 value.) 

 

 

2.14 VibroSight Capture and machine trains for Pelton turbines 

In VibroSight Capture, it is now possible to develop machine trains for hydro turbine applications using Pelton 
wheels in a much wider variety of machinery configurations. 

More specifically, in VibroSight Capture machine trains, the Pelton machinery component has been improved to 
incorporate two connection points (both left and right), in order to help support the wide range of different hydro 
turbine configurations in use worldwide. For example, this allows a hydro turbine using Pelton wheels on either side 
of a generator to be easily represented. 

Previously, the Pelton machinery component provided a single connection point only (on the left), which prevented 
certain configurations. 
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2.15 VibroSight Protect Dashboard has improved handling of VM600Mk2 MPC4Mk2 modules in 
Recovery mode 

In VibroSight Protect, the behaviour and functionality of the Dashboard tab/page has been improved to work better 
with VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules that are in the 
Recovery mode. 

NOTE: For a VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring 
module, the Recovery mode is a mode of operation that allows the end-
user/operator to change/upload MPC4Mk2 module firmware (which is required for a 
module delivered as a spare part). 
The Recovery mode also allows a module to be recovered in the unlikely event of a 
problem such as corrupted operational firmware (machinery protection and/or 
condition monitoring) or a corrupted configuration. 
It is important to note that entering the Recovery mode automatically clears the 
module’s configuration, which means that the module (system) must be 
reconfigured after leaving the Recovery mode – before normal system operation 
can be resumed. 

 

On the Dashboard tab/page, when a VM600Mk2 MPC4Mk2 + IOC4Mk2 module in Recovery mode is selected in a rack 
slot position (top) or System pane (right), VibroSight Protect will periodically check the module (approx. every 15-
30 seconds) to see if the status of the module changes. For example, to see if the module is still in Recovery mode 
or if the module firmware has been updated and/or if the module has been rebooted (restarted). 
In addition, the messages displayed by the Dashboard tab/page have been improved in order to be more correct 
and useful. For example, when VibroSight Protect detects a VM600Mk2 MPC4Mk2 + IOC4Mk2 module in recovery 
mode, it now displays the message: 
“The selected device is using a firmware that is incompatible with this version of Protect or the device is currently in 
recovery mode. Please update the firmware or exit recovery mode”. 

 

Previously, when VibroSight Protect detected a VM600Mk2 MPC4Mk2 + IOC4Mk2 module in recovery mode, it simply 
displayed an erroneous message: “The selected device contains a firmware that is not compatible with this version 
of Protect” and would not re-check the module to see if the situation changed. 
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2.16 VibroSight Protect Dashboard has improved display of Alarm controls information for 
VM600Mk2 MPC4Mk2 modules 

In VibroSight Protect, the behaviour and functionality of the Dashboard tab/page has been improved to work better 
with the Alarm controls information for VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition 
monitoring modules, specifically, the discrete signal interface (DSI) signals and the channel bypass control signals. 

NOTE: For the VM600Mk2 MPC4Mk2 + IOC4Mk2 module, Alarm controls consist of discrete 
signal interface (DSI) signals and channel bypass signals. 

There are three DSI control signals: Alarm bypass (AB), Alarm reset (AR) and 
Trip Multiply (TM). 

There are channel bypass signals for each measurement channel: 4 dynamic 
channels and 2 auxiliary channels. 

These signals are a mixture of VibroSight Protect Dashboard control switches, 
DSI physical inputs (rear of VM600Mk2/VM600 rack) and/or VME bus commands. 

 

On the Dashboard tab/page, when a VM600Mk2 MPC4Mk2 + IOC4Mk2 module is selected in a rack slot position (top) 
or System pane (right), VibroSight Protect now displays the Alarm controls (that is, DSI and channel bypass) 
information in an improved way in order to provide the user with better visibility and control of these signals. 

 

 
Figure 8: VibroSight Protect Dashboard Alarm controls information 

 

In VibroSight Protect Dashboard, the associated tooltips can be used to learn more about each Alarm controls 
function. 
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Trip multiply 

The Trip multiply (TM) function can be controlled via the VibroSight Protect Dashboard Trip multiply switch, the 
VM600Mk2 IOC4Mk2 control input signal or a VME bus command from a VM600Mk2 CPUMMk2 module. 

A Trip multiply combined switch/indicator is displayed on the VibroSight Protect Dashboard, under Alarm controls, 
according to the following logic: 

VM600Mk2 IOC4Mk2 

Trip multiply (TM) 
DSI control input 

VME bus command VibroSight Protect Dashboard 
Trip multiply control 

Off Off 
The on/off switch can control 

the function 

Off On 
“On via CPUM command” 

is displayed 

On --- 
“On via IOC4 digital input” 

is displayed 

 

 
Alarm bypass 

The Alarm bypass (AB) function can be controlled via the VibroSight Protect Dashboard Alarm bypass switch, the 
VM600Mk2 IOC4Mk2 control input signal or a VME bus command from a VM600Mk2 CPUMMk2 module. 

An Alarm bypass combined switch/indicator is displayed on the VibroSight Protect Dashboard, under Alarm 
controls, according to the following logic: 

VM600Mk2 IOC4Mk2 

Alarm bypass (AB) 
DSI control input 

VME bus command VibroSight Protect Dashboard 
Alarm bypass control 

Off Off 
The on/off switch can control 

the function 

Off On 
“On via CPUM command” 

is displayed 

On --- 
“On via IOC4 digital input” 

is displayed 
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Channel bypass 

Channel bypass functions can be controlled via a VibroSight Protect Dashboard Channel x bypass switch, or a 
VME bus command from a VM600Mk2 CPUMMk2 module. 

A Channel x bypass combined switch/indicator is displayed on the VibroSight Protect Dashboard (for each 
configured channel), under Alarm controls, according to the following logic: 

VME bus command VibroSight Protect Dashboard 
Alarm bypass control 

Off 
The on/off switch can control 

the function 

On 
“On via CPUM command” 

is displayed 

 

 

NOTE: The Alarm bypass (AB) function is a module-wide function that is equivalent to the 
use of a channel bypass function on each individual channel of the module, and 
vice versa. 
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VM600Mk2 modules 

2.17 MPC4Mk2 + IOC4Mk2 module hardware (standard and SIL versions) 

The MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module and the RLC16Mk2 relay module are 
available in different versions – standard and SIL – as follows: 

• MPC4Mk2 + IOC4Mk2 and RLC16Mk2 – these are the standard versions of the modules, suitable for most 
applications. 
Note: PNRs 600-041 for the MPC4Mk2, 600-043 for the IOC4Mk2 and 600-045 for the RLC16Mk2. 

• MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL – these are the SIL safety versions of the modules, suitable for 
critical applications demanding the highest level of protection. 
Note: PNRs 600-040 for the MPC4Mk2 SIL, 600-042 for the IOC4Mk2 SIL and 600-044 for the RLC16Mk2 SIL. 

 

See also 2.18 MPC4Mk2 + IOC4Mk2 module firmware and 2.19 MPC4Mk2 + IOC4Mk2 SIL module firmware. 

 

 

2.18 MPC4Mk2 + IOC4Mk2 module firmware (standard) 

NOTE: Standard versions of firmware are for use with the MPC4Mk2 + IOC4Mk2 module only 
(that is, PNR 600-041 for the MPC4Mk2). 

 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module firmware with 
the following main improvements: 

 

Machinery protection firmware: 640-025-011-000 

NOTE: VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-011-000) is 
compatible with both versions of the MPC4Mk2 module (PNRs 600-041-000-vvv and 
600-041-001-vvv). 

 

New features: 

• Support for “Reverse rotation” processing (dual-channel). 

• Support for discrete signal interface (DSI) information (Alarm bypass (AB), Alarm reset (AR) and Trip multiply 
(TM)) to be shared with VM600Mk2 CPUMMk2 via VME. 

• Alarm reset (AR) status created and maintained for 5 seconds. 

• VME to provide diagnostic code and error class (global status information). 
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• Module CRC checksum (“signature”) corresponding to the configuration of the protection function (that is, the 
machinery protection functionality configured for and running on the module). 

• Enhanced Alarm event reporting (with outputID argument). 

Bug fixes: 

• Handling, storage and use of IP address, subnet mask and default gateway addresses. 

• Data availability and channel masks for condition monitoring data (Data Availability for XNP dataclass CMSP 
returned the first DUAL channel when the AUX was requested). 

• Spikes in decay of speed when no pulses are received for configurations with more pulses per rotation 
(SigProcLib). 

Restrictions: 

• Compatible with VibroSight 7.7 only. 

See also 5.2 VM600Mk2/VM600 modules (cards). 

 

Condition monitoring firmware: 640-033-007-000 

New features: 

• Support for “Reverse rotation” processing (dual-channel). 

Bug fixes: 

• Alarms layer seems to differ from process data implementation (condition monitoring). 

• Spikes in decay of speed when no pulses are received for configurations with more pulses per rotation 
(SigProcLib). 

Restrictions: 

• Compatible with VibroSight 7.7 only. 

See also 5.2 VM600Mk2/VM600 modules (cards). 

 

Recovery firmware: 640-031-007-001 

Bug fixes: 

• Handling, storage and use of IP address, subnet mask and default gateway addresses. 

Restrictions: 

• Compatible with VibroSight 7.7 only. 

See also 5.2 VM600Mk2/VM600 modules (cards). 
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2.19 MPC4Mk2 + IOC4Mk2 SIL module firmware (SIL) 

NOTE: SIL versions of firmware are for use with the MPC4Mk2 + IOC4Mk2 SIL module only 
(that is, PNR 600-040 for the MPC4Mk2 SIL). 

 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 SIL machinery protection and condition monitoring module firmware with 
the following main improvements: 

 

SIL machinery protection firmware: 640-024-002T004 

New features: 

• Support for discrete signal interface (DSI) information (Alarm bypass (AB), Alarm reset (AR) and Trip multiply 
(TM)) to be shared with VM600Mk2 CPUMMk2 via VME. 

• VME to provide diagnostic code and error class (global status information). 

Bug fixes: 

• Handling, storage and use of IP address, subnet mask and default gateway addresses. 

• Data availability and channel masks for condition monitoring data (Data Availability for XNP dataclass CMSP 
returned the first DUAL channel when the AUX was requested). 

Restrictions: 

• Compatible with VibroSight 7.7 only. 

See also 5.2 VM600Mk2/VM600 modules (cards. 

 

NOTE: It is important to be aware that this latest SIL machinery protection firmware 
(640-024-002T004) is a “beta” release for the future 640-024-002-000 – intended 
for test and evaluation only. SIL re-certification is pending. 

Accordingly, with this latest SIL machinery protection firmware the MPC4Mk2 
module cannot be Locked (that is, cannot be put into the safety/secure operating 
mode (of the Operational mode)). 

Firmware upgrades to final versions of SIL-specific firmware will be required before 
a VM600Mk2 SIL system containing MPC4Mk2 + IOC4Mk2 SIL modules can be used in 
critical safety-related applications. 
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SIL recovery firmware: 640-026-002-001 

Bug fixes: 

• Handling, storage and use of IP address, subnet mask and default gateway addresses. 

Restrictions: 

• Compatible with VibroSight 7.7 only. 

See also 5.2 VM600Mk2/VM600 modules (cards). 

 

 

VM600 modules 

2.20 CPUMMk2 + IOCNMk2 module firmware 

Updated VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module firmware with the 
following main improvements: 

 

Base-system / Applications firmware: base-system-640-034-005-001 

New features: 

• Added support for voting logic in the Modbus configuration file (Modbus VOTE function). 

• Improved updating of password file (atomic operation). 

• Improved error handling for more robust communications with VM600Mk2 MPC4Mk2 modules. 

• Improved reporting of module errors via Modbus with new fail-safe error acknowledgment 
(Modbus ACKNOWLEDGE_FAILSAFE function). 

• VM600Mk2 CPUMMk2 Modbus data now includes the status of all VM600Mk2 MPC4Mk2 discrete signal interface 
(DSI) signal (Alarm bypass (AB), Alarm reset (AR) and Trip multiply (TM)), and the status of the VM600Mk2 
CPUMMk2 alarm reset button. 
Note: This allows external third-party devices such as a DCS or PLC to monitor that commands have been 
executed. 

Bug fixes: 

• Fix the status delay operator. 
Note: The SFI check delay on the lower limit did not work correctly, causing the “Bad Sensor” status to be set 
immediately after an event, without waiting for it to keep the bad state for the configured time. 

• Not accepting Modbus configuration files with lines ending with a CR only (instead of CR+LF). 

• Problem when re-configuring a CPUMMk2 to no longer handle/manage a VM600Mk2/VM600 XMx16 + XIO16T 
extended condition monitoring module (that is, the XMx16 pairing was not being properly released). 

• Special characters (such as an ampersand (&)) in the rack / system name do not allow the XNP main service to 
start (effectively blocking communications). 
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Restrictions: 

• Compatible with the following VM600Mk2 MPC4Mk2 modules: standard version running machinery protection 
firmware 640-025-011-000 or later, and SIL version running machinery protection firmware 640-024-002T004 
or later. 

See also 5.2 VM600Mk2/VM600 modules (cards). 

 

 

2.21 XMx16 + XIO16T module firmware 

Updated VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring module firmware with the following 
main improvements: 

 

Applications firmware: applications-640-010-001-018 and  
Base-system firmware: base-system-640-003-001-018 

Bug fixes: 

• Application exits after a series of tmp_HFSD overflow messages (in the log). 

• NTPD (Network Time Protocol daemon) not able to update system time. 

Restrictions: 

• Compatible with VibroSight 7.5 or later. 

See also 5.2 VM600Mk2/VM600 modules (cards). 

 

 

VibroSmart modules 

2.22 VSI010 + VSB010 module firmware 

Updated VibroSmart VSI010 + VSB010 communications interface module firmware with the following main 
improvements: 

 

642-002-000-016 

Bug fixes: 

• Profinet MAC address send to the netX interface chip incorrectly converted from the module’s UniqueID. 

Restrictions: 

• Compatible with VibroSight 7.6 or later. 

See also 5.3 VibroSmart devices.  
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3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 7.7.0 software. 

 

3.2 VibroSight Server problem with CSV data import 

When trying to import data into a VibroSight Server via a CSV data file, the data was not imported. 

Instead, error and warning messages about the (in)validity of the CSV file were displayed, for example: 
“Error: Error during CSV data importation when checking validity of file.” 
“Warning: File can’t be processed because it is not valid : ‘C:\Users\ …\CSV data file.csv’” 

 

3.3 VibroSight Vision problem with the scaling of X and Y axes in plots 

In VibroSight Vision, the appearance of the X and Y axes in plots had changed with larger font/text sizes used and 
the axes seeming not to scale properly with overlapping/truncated text, particularly with multiple plots in a single 
window – leading to problems with legibility. 

Note: This problem was first noticed in VibroSight 7.4, with the switch to .NET core (.NET 7.0 SDK v7.0.306). The 
main problem was an underlying graphics library (LightningChart) which had some compatibility issues but has 
since been updated. 

 

3.4 VibroSight Vision removing VM600Mk2 MPC4Mk2 module protection measurements from plots 
after configuration changes 

When VibroSight Vision is connected directly to a VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and 
condition monitoring module, and a machinery protection measurement was added to a plot, when 
VibroSight Protect was used to make subsequent changes to the module’s configuration, the measurement was 
inadvertently removed from the plot when the configuration was activated. 

 

3.5 VibroSight Server using a NTP server as a time reference stops logging data following large 
time differences between the VibroSight Server and NTP server 

For a VibroSight Server using a NTP server as a time reference, when the external time reference (NTP server) 
moved forward abruptly (for example, +1 hour), then the VibroSight server stopped logging data, and live data was 
no longer available in VibroSight Vision. 
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3.6 VibroSight Protect using the wrong image for VM600Mk2 MPC4Mk2 module’s dual-channel 
shaft axial position (collar) processing 

When configuring dual-channel shaft axial position (collar) processing for a VM600Mk2 MPC4Mk2 + IOC4Mk2 
machinery protection and condition monitoring module, VibroSight Protect displayed/used the wrong image in the 
channel configuration wizard (and elsewhere). 

 

3.7 VibroSight Vision X orbit not consistent with OVR orbit 

In VibroSight Vision, when using orbit plots to display filtered orbit data, waveform data (such as 1X, 3X) was not 
“aligned” with the OVR waveform data, that is, the data seemed to be incorrectly displayed with an inversion or 
phase offset. 

Note: This issue is for a configuration created using VibroSight Capture (that is, it is not present for a configuration 
created using VibroSight Confgurator). 

 

3.8 VibroSight Protect reporting that an update rate is not supported 

In VibroSight Protect, when editing a configuration, the consistency checker incorrectly reported that an update rate 
was not supported even though this parameter is only configurable via VibroSight Capture. For example: 

“Update rate 0.00.00 is not supported. The allowed update rates are 0.00.00.1, 0.00.00.2, 0.00.00.5, 0.00.01, 
0.00.02, 0.00.05, 0.00.10, 0.00.20, 0.00.30, 0.01.00.” 

 

3.9 VibroSight Capture problem connecting a reference speed measurement channel to a 
machine train 

In VibroSight Capture, when connecting a reference speed measurement channel (that is, speed processing) to a 
machine train component (on the Connect tab/page), the reference speed field (on the Machinery tab/page, left) 
was not automatically completed/updated (as it should be). 

Note: A workaround being that the VibroSight Capture configuration had to be saved, then closed and reopened in 
order for the reference speed field to be correctly displayed. 

 

3.10 VibroSight Protect Dashboard not resuming normal operation after a VM600Mk2 MPC4Mk2 
SIL module reboots 

In VibroSight Protect, on the Dashboard tab/page, when a VM600Mk2 MPC4Mk2 SIL + IOC4Mk2 SIL machinery 
protection and condition monitoring module was reset using the two front panel buttons (that is, forced to reboot), 
the Dashboard did not resume display of the module information as expected, rather it reported that the module 
was not configured. 
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3.11 VibroSight Vision plots not displaying historical data correctly 

In VibroSight Vision, different plot types (such as Trend plots, Long Waveform plots and Waveform plots) were not 
displaying historical data in the plots, rather the plots displayed “There is no available data to display” even though 
data was known to be available. 

This could happen when the data Measurements (left) were dragged and dropped into the plot and/or when the 
Time Range (right) was set to Custom historical, and Apply control was clicked. 

 

3.12 VibroSight Configurator not allowing OPC UA tags with double data type to be selected 

In VibroSight Configurator, when configuring an OPC UA client to import data from an external data source into a 
VibroSight Server database, OPC UA tags using the “double” data type could not be selected, that is, the OK 
control used for node selection became unavailable / grayed out. 

 

3.13 VibroSight Protect logical functions not always easy to configure 

In VibroSight Protect, when configuring logical functions in the main window (center), the configuration of larger 
and/or more complex logical functions becomes difficult as the required components (Shapes: Input, And, Not, Or 
and Vote) remain on the top left of the main window as the working area automatically extends downwards to 
accommodate more components as they are added, resulting in lots of scrolling up and down. 

 

3.14 VibroSight Server problem communicating with VM600Mk2/VM600 XMx16T module 

When a VibroSight Server is connected to a VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring 
module and the module’s configuration is cleared/deleted and then the module is restarted, the VibroSight Server 
re-establishes communications with the module, but after connecting the VibroSight Server incorrectly considers 
that the local (Server) and remote (module) configurations are still the same. 

This is typically characterised by the VibroSight Server displaying a message such as the following: 

Date  Time  Logger    Message 

2/14/2025 10:20:35.630 Xmc.Driver.XmcDeviceDriver VM600 Card Driver: XMx Card E136044 paired successfully. 

2/14/2025 10:20:35.630 Xmc.Driver.XmcDeviceDriver VM600 Card Driver: Get the configuration of the card E136044. 

2/14/2025 10:20:35.719 Xmc.Driver.XmcDeviceDriver VM600 Card Driver: Configuration got from the card E136044 to check if it is 

required to set it again. 

2/14/2025 10:20:35.829 Xmc.Driver.XmcDeviceDriver VM600 Card Driver: Current configuration set on card E136044 matches the 

server's one, no need to set a new configuration. 

2/14/2025 10:20:38.524 Xmc.Driver.XmcDeviceDriver The version contained in the data is invalid. Configuration version: 0, data 

version: 1178711696. The version contained in the data is invalid. Configuration version: 11511177, data version: 1178711696. 
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4 Known issues 

4.1 Security risks 

A number of Open web application security project (OWASP) security risks have been identified related to a 
UPC UA library used by the VibroSight software. This UPC UA library is from a third-party (Softing AG, Softing 
Industrial Automation GmbH), who have recently implemented a fix. However the improved UPC UA library is not 
included in the latest release of VibroSight. 

For information, the specific issues that have been identified are: 

• CVE-2022-29862: An infinite loop in OPC UA .NET Standard Stack 1.04.368 allows a remote attackers to 
cause the application to hang via a crafted message 

• CVE-2022-29863: OPC UA .NET Standard Stack 1.04.368 allows remote attacker to cause a crash via a 
crafted message that triggers excessive memory allocation. 

• CVE-2022-29864: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to cause a server to crash 
via a large number of messages that trigger Uncontrolled Resource Consumption. 

• CVE-2022-29865 : OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to bypass the application 
authentication check via crafted fake credentials 

• CVE-2022-29866: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to exhaust the memory 
resources of a server via a crafted request that triggers Uncontrolled Resource Consumption. 

 

4.2 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

4.3 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

4.4 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 
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NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 

NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 

4.5 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 

4.6 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 modules/cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 
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4.7 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 

 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 

4.8 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 
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If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 

4.9 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 

4.10 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 

4.11  XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 
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4.12  Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully run. 

NOTE: The VibroSight software’s TCP and UDP port requirements are described in detail 

in the “Software installation” section of the latest  Getting started with 
VibroSight installation guide. See section 4. After installing VibroSight. 

 

4.13  Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 
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This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 
 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

 

  

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 0) must be manually installed before 
VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 0) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 0) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

5.1 VibroSight software 

VibroSight 7.7.0 is a minor level release and replaces VibroSight 7.6.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved by automatically applying an 
internal data migration process from existing VibroSight databases (VibroSight historical data folders (*.vshdf) 
and/or VibroSight historical data archives (*.vshda)), if and when required. 

NOTE: Since VibroSight 7.4.0, it is no longer possible to migrate older machinery 
monitoring projects using Sybase SQL Anywhere databases to VibroSight historical 
data repositories. 

In order to migrate such older projects using Sybase SQL Anywhere databases to 
VibroSight historical data repositories, VibroSight 7.3.x or earlier 
(also VibroSight 3.x.x or later) must be used. 

 
Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 7.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 



 

RELEASE NOTES 
VibroSight® 7.7.0 
44 / 84 

Document reference VIBROSIGHT-RN/E (660-010-013-240A) 
Version 40 – 28.03.2025 

 

• For existing machinery monitoring projects using VibroSight historical data repositories, the VibroSight 
historical data repositories are automatically updated if and when required (for example, to support new 
features). 

• For existing machinery monitoring projects using Sybase SQL Anywhere databases (that is, created with 
versions of VibroSight earlier than VibroSight 3.0.0), the project must be manually migrated from Sybase SQL 
Anywhere databases to VibroSight historical data repositories. 

Note: This data migration must be done using VibroSight 7.3.x or earlier (also VibroSight 3.x.x or later) – before 
they can be used with VibroSight 7.x.x (also VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.3.x or earlier (also VibroSight 3.x.x or later) is described in detail in the 

“Data migration” section of the  Getting started with VibroSight installation 
guide  
(Note: For example, using the VibroSight 7.3.x software – see the earlier version of 
the installation guide: version 33.) 

The manual migration of a VibroSight OPC server is described in detail in the 
“VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide  
(Note: For example, using the VibroSight 7.4.x software – see the earlier version of 
the installation guide: version 34.) 

 
5.1.1 Microsoft Windows operating systems 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 
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5.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 7.4.x or later requires that the .NET 7.0 SDK and the 
Microsoft .NET Framework 4.7.2 or later is installed. 

NOTE: VibroSight 7.4.x or later requires Microsoft .NET 7.0 SDK (v7.0.306 or later). 

VibroSight 7.x.x requires the Microsoft .NET Framework 4.7.2. 

 
If Microsoft .NET SDK v7.0.306 or later is not already installed on the computer that will run VibroSight, then it must 
be installed manually by the user using one of Microsoft’s .NET SDK installers. 

If Microsoft .NET Framework 4.7.2 is not already installed on the computer that will run VibroSight, then the 
VibroSight installer will detect this and automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 

requirements. Refer also to the latest  Getting started with VibroSight installation guide. 

 

5.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 
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If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

5.1.5 OPC UA Local Discovery Server  

VibroSight 7.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 

 

5.1.6 Sybase SQL Anywhere 11 software 

VibroSight 7.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Since VibroSight 7.4.0, it is no longer possible to migrate older machinery monitoring projects using Sybase SQL 
Anywhere databases to VibroSight historical data repositories. 

For further information on VibroSight and Sybase SQL Anywhere, including the manual migration of older projects 
using Sybase SQL Anywhere to VibroSight, refer to VibroSight 7.3.x or earlier release notes and/or installation 
guide. 

See also 5.1 VibroSight software. 

 

5.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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5.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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5.2 VM600Mk2/VM600 modules (cards)  

5.2.1 Module (card) firmware 

There are some firmware upgrades for VM600Mk2/VM600 modules (cards) corresponding to VibroSight 7.7.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 module is now: 

• Machinery protection: 640-025-011-000.Mpc4g2Fw (updated) 

• Condition monitoring: 640-033-007-000.VxeFw (updated) 

• Recovery: 640-031-007-001.Mpc4g2Fw (updated) 

• Protection test: 640-032-004-001.VxeFw. 

See 2.17 MPC4Mk2 + IOC4Mk2 module hardware (standard and SIL versions) and 2.18 MPC4Mk2 + IOC4Mk2 module 
firmware (standard). 

 

The latest firmware for the VM600Mk2 MPC4Mk2 SIL module is now: 

• Machinery protection: 640-024-002T004.SafeMpc4g2Fw (updated) 

• Condition monitoring: 640-033-007-000.VxeFw (updated) 

• Recovery: 640-026-002-001.SafeMpc4g2Fw (updated) 

• Protection test: 640-032-004-001.VxeFw. 

See 2.17 MPC4Mk2 + IOC4Mk2 module hardware (standard and SIL versions) and 2.19 MPC4Mk2 + IOC4Mk2 SIL 
module firmware (SIL). 

 

The latest firmware for the VM600Mk2 CPUMMk2 module is now: 

• Base-system: base-system-640-034-005-001.tgz. 

See 2.20 CPUMMk2 + IOCNMk2 module firmware. 

 

The latest firmware for the VM600 CPUR2 card remains: 

• Applications: applications-640-015-001-007.tgz 

• Base-system : base-system-640-014-001-007.tgz. 

 

The latest firmware for the VM600 CPUR card remains: 

• Applications: applications-640-012-001-005.tgz 

• Base-system: base-system-640-011-001-005.tgz. 
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The latest firmware for the VM600Mk2/VM600 XMC16, XMV16 and XMVS16 cards is now: 

• Applications: applications-640-010-001-018.tgz 

• Base-system: base-system-640-003-001-018.tgz. 

See 2.21 XMx16 + XIO16T module firmware. 

 

Therefore, for current versions of VibroSight and VM600Mk2/VM600 systems, firmware upgrades are required. 

 

 

5.3 VibroSmart devices 

5.3.1 Module firmware 

There are some firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 7.7.0. 

 

The latest firmware for the VSV30x module remains: 

• 642-001-000-022.xtranfw  

 

The latest firmware for the VSI010 module is now: 

• 642-002-000-016.xmsifw  

See 2.22 VSI010 + VSB010 module firmware. 

 

The latest firmware for the VSN010 device remains: 

• 642-004-000-013.redboxfw  

 

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are recommended. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: Before starting a VibroSight system update, it is strongly recommended to verify 
the version of firmware(s) running on the related hardware (VM600Mk2/VM600 
and/or VibroSmart modules/devices) in order to establish if any firmware 
changes/upgrades are also required. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

IMPORTANT 
NOTE: 

Before upgrading the firmware of any of the hardware (VM600Mk2/VM600 and/or 
VibroSmart modules/devices) used in a VibroSight system, it is strongly 
recommended to ensure that a copy of the configuration for the system is available 
– in case it is necessary to reconfigure the system after the upgrade. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600Mk2/VM600 and/or VibroSmart 
modules/devices to be upgraded to the latest firmware, in order to take advantage of improvements to the 
VibroSight software. 

NOTE: Updating the firmware for VM600Mk2/VM600 and/or VibroSmart modules/devices is 
a special task that can, if used unintentionally or incorrectly, lead to malfunctioning 
of the device and affect proper function of data acquisition. It is therefore strongly 
recommended to change the firmware of VibroSight-compatible hardware only 
when it is necessary. For example, when the devices must be updated to be 
compatible with a VibroSight software upgrade. 

During the firmware update of a device, the card or module being updated cannot 
provide its normal machinery monitoring functions because its outputs (alarms and 
relays) can go to undetermined states, irrespective of how they have been 
configured. 

 

IMPORTANT 
NOTE: 

It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

For example, for VibroSmart modules, the machinery being monitored is not protected for the duration of a 
firmware update and the restart (reboot) that is triggered automatically after the firmware update (which can take up 
to 5 minutes). 
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6.2.1 VM600Mk2/VM600 module/card firmware 

The latest VM600Mk2/VM600 module/card firmware files are copied to a directory on your computer as part of the 
VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600Mk2/VM600 modules/cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600Mk2/VM600 module/card can be found in the appropriate subfolder and identified by 
their .tgz file name extension. 

For example, the MPC4 Mk2 subfolder contains the firmware components for use by the MPC4Mk2 module 
(standard versions) and the MPC4 Mk2 SIL subfolder contains the firmware components for use by the 
MPC4Mk2 SIL module (SIL versions). Any additional firmware updates received from parker Meggitt (Meggitt SA) 
should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for later versions of the MPC4Mk2 (PNRs 600-041-001-002 and 600-041-000-002). 

Table 2 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for the original version of the MPC4Mk2 (PNR 600-041-000-001) – no longer supported. 
See 2.17 MPC4Mk2 + IOC4Mk2 module hardware. 

Table 3 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 SIL module hardware (that 
is, MPC4Mk2 SIL firmware). 

IMPORTANT 
NOTE: 

When changing (upgrading) all firmware components on a VM600Mk2 MPC4Mk2 
module, the module must be in the Recovery mode in order to change the 
protection test firmware. 

It is important to note that entering the Recovery mode clears the modules 
configuration, which means that the module (system) must be reconfigured after 
leaving the Recovery mode – before normal system operation can be resumed. 

Accordingly, it is strongly recommended to ensure that a copy of the configuration 
for the system is available before upgrading a system. For example, the VibroSight 
software can be used to connect to a system (which will automatically 
read/download the system configuration) and save a copy of the configuration. 

 

 

Table 4 shows the compatibility between VibroSight software and VM600Mk2 CPUMMk2 module hardware (that is, 
CPUMMk2 firmware). 

Table 5 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 6 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 
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Table 7 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 

 

 

 

  



 

RELEASE NOTES 
VibroSight® 7.7.0 
54 / 84 

Document reference VIBROSIGHT-RN/E (660-010-013-240A) 
Version 40 – 28.03.2025 

 

 



 

Document reference VIBROSIGHT-RN/E (660-010-013-240A) 
Version 40 – 28.03.2025 

RELEASE NOTES 
VibroSight® 7.7.0 

55 / 84 
 

Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 
for later standard versions of the MPC4Mk2 (PNRs 600-041 / 600-041-001-002 and 600-041-000-002) 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

640-025- 

007-001 

640-025- 

008-000 

640-025- 

009-001 

640-025- 

010-000 

640-025- 

011-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- 640-033- 

001-000 

640-033- 

002-000 

640-033- 

003-000 

640-033- 

004-000 

640-033- 

005-000 

640-033- 

006-000 

640-033- 

007-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-006 

640-031- 

005-001 

640-031- 

006-000 

640-031- 

007-000 

640-031- 

007-001 

Protection test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-001 

640-032- 

003-000 

640-032- 

004-000 

640-032- 

004-001 

7.0.0 
609-010-000-001 

 See note 1a 
 See 

note 1b 

      

7.1.0 
609-010-000-001 

   See 

note 2 

     

7.2.0 
609-010-000-001 

    See 

note 3 

    

7.3.0 
609-010-000-001 

     See 

note 4 

   

7.4.0 
609-010-000-001 

      See 

note 5 
  

7.5.0 
609-010-000-001 

        

7.6.0 
609-010-000-001 

       See note 6  

7.7.0 
609-010-000-001 

        See 

note 7 
Notes for Table 1 (see the next page)  
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Notes for Table 1 
 
1a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 
1b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 
2. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 
3. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.2 release notes. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
 
4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is required in order to run VibroSight 7.3.0 or later. 
 
5. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.4 release notes. 
A firmware upgrade is required in order to run VibroSight 7.4.0 or later. 
 
6. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
 
7. For information on these versions of VM600Mk2 MPC4Mk2 firmware, see 2.18 MPC4Mk2 + IOC4Mk2 module firmware. 
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
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Table 2: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

for the original standard version of MPC4Mk2 (PNRs 600-041 / 600-041-000-001) – no longer supported 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

003-002 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- --- 640-033- 

001-000 

640-033- 

002-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-002 

640-031- 

003-004 

640-031- 

003-006 

Protection test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-000 

640-032- 

001-001 

6.0.0 
609-004-000-050 

 See note 1  
   

6.1.0 
609-004-000-051 

  See note 2   
 

7.0.0 
609-010-000-001 

   See note 3a  See note 3b 
 

7.1.0 
609-010-000-001 

     See note 4 

 

Notes for Table 2 (see the next page) 
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Notes for Table 2 
 

1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – that is, to use VM600Mk2 
systems in “live” machinery protection system (MPS) applications. Contact Parker Meggitt (Meggitt SA) for further information. 
 

2. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 
3a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

3b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0. 
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Table 3: VibroSight software and VM600Mk2 MPC4Mk2 SIL firmware compatibility 

for the SIL version of the MPC4Mk2 (PNRs 600-040 / 600-040-vvv-vvv) 

 VM600Mk2 MPC4Mk2 SIL firmware 

VibroSight software 
version 

Part number (PNR) 

SIL machinery protection firmware 
(640-024-vvv-ppp.SafeMpc4g2Fw) 

640-024-001T005 640-024-

001T006 

640-024-

001-000 

640-024-

002T002 

640-024-

002T004 

Condition monitoring firmware 
(640-033-vvv-ppp.VxeFw) 

640-033-004-000 640-033-005-000 640-033-006-

000 

640-033-

007-000 

SIL recovery firmware  
(640-026-vvv-ppp.SafeMpc4g2Fw) 

640-026-001-000 640-026-002-

000 

640-026-

002-001 

Protection test firmware 
(640-032-vvv-ppp.VxeFw) 

640-032-004-000 640-032-004-001 

7.3.0 
609-010-000-001 

 See note 1  
   

7.4.0 
609-010-000-001 

  See note 2    

7.5.0 
609-010-000-001 

   See note 3   

7.6.0 
609-010-000-001 

    See note 4  

7.7.0 
609-010-000-001 

     See note 5 
 

Notes for Table 3 
 
1. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is required in order to run VibroSight 7.3.0 or later. 
 
2. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.4 release notes. 
A firmware upgrade is required in order to run VibroSight 7.4.0 or later. 
 
3. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.5 release notes. 
A firmware upgrade is required in order to run VibroSight 7.5.0 or later. 



 

RELEASE NOTES 
VibroSight® 7.7.0 
60 / 84 

Document reference VIBROSIGHT-RN/E (660-010-013-240A) 
Version 40 – 28.03.2025 

 

 
4. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
 
5. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, see 2.19 MPC4Mk2 + IOC4Mk2 SIL module firmware. 
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
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Table 4: VibroSight software and VM600Mk2 CPUMMk2 firmware compatibility 

 VM600Mk2 CPUMMk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Base-system / Applications firmware (*.tgz) 

640-034- 

001-000 

640-034- 

001-001 

640-034- 

002-000 

640-034- 

003-000 

640-034- 

003-001 

640-034- 

004-000 

640-034- 

005-001 

6.1.0 
609-004-000-051 

 See note 1   
    

7.0.0 
609-010-000-001 

  See note 2  
    

7.1.0 
609-010-000-001 

   See note 3  
   

7.2.0 
609-010-000-001 

    See note 4 
   

7.3.0 
609-010-000-001 

     See note 5   

7.4.0 
609-010-000-001 

       

7.5.0 
609-010-000-001 

      See note 6  

7.6.0 
609-010-000-001 

       

7.7.0 
609-010-000-001 

       See note 7 
 

Notes for Table 4 
 

1. This version of VM600Mk2 CPUMMk2 firmware is the official launch release of firmware supporting VM600Mk2 systems. (Refer to the 
VibroSight 6.1 release notes for further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

2. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

3. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

4. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.2 release notes. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
 

5. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is not required but is strongly recommended in order to run VibroSight 7.3.0 or later. 
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6. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.5 release notes. 
It is important to note that this firmware version is incompatible with previous VM600Mk2 CPUMMk2 firmware versions or the VM600 CPUR2 card 
and may cause hardware damage if installed. Therefore, to ensure compatibility and prevent any issues, a VM600Mk2/VM600 rack should only 
contain CPUMMk2 modules with firmware version 640-034-004-000 or later. Also, during the firmware upgrade process, it's crucial to remove all 
other VM600Mk2 CPUMMk2 modules or VM600 CPUR2 cards from the rack in order to avoid potential damage. That is, ensure that only the 
VM600Mk2 CPUMMk2 module receiving the firmware upgrade is present in the rack during the upgrade process. 
A firmware upgrade is required in order to run VibroSight 7.5.0 or later. 
 

7. For information on this version of VM600Mk2 CPUMMk2 firmware, see 2.20 CPUMMk2 + IOCNMk2 module firmware. 
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
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Table 5: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-014- 

001-002 

640-014- 

001-003 

640-014-001-

005 

640-014-001-

006 

640-014-001-

007 

Applications firmware (*.tgz) 

640-015- 

001-002 

640-015- 

001-003 

640-015- 

001-005 

640-015- 

001-006 

640-015- 

001-007 

5.0.0 
609-004-000-048 

 See note 2  See note 3  
  

5.1.0 
609-004-000-049 

   
  

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
  

7.0.0 
609-010-000-001 

   See note 4 
  

7.1.0 
609-010-000-001 

    See note 5  

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

7.4.0 
609-010-000-001 

     

7.5.0 
609-010-000-001 

     

7.6.0 
609-010-000-001 

     See note 6 

7.7.0 
609-010-000-001 

     
Notes for Table 5 (see the next page) 
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Notes for Table 5 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base-system and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in 
the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base-system and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
 

3. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

5. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 
6. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.6 release notes. 
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Table 6: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-011-001-004 640-011-001-005 

Applications firmware (*.tgz) 

640-012-001-004 640-012-001-005 

5.0.0 
609-004-000-048 

 See note 2  See note 3 

5.1.0 
609-004-000-049 

  

6.0.0 
609-004-000-050 

  

6.1.0 
609-004-000-051 

  

7.0.0 
609-010-000-001 

  

7.1.0 
609-010-000-001 

  

7.2.0 
609-010-000-001 

  

7.3.0 
609-010-000-001 

  

7.4.0 
609-010-000-001 

  

7.5.0 
609-010-000-001 

  

7.6.0 
609-010-000-001 

  

7.7.0 
609-010-000-001 

  
 

Notes for Table 6 (see the next page)  
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Notes for Table 6 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base-system and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in 
the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base-system and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-vvv)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 
 
3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 7: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-003-001-016 640-003-001-017 640-003-001-018 

Applications firmware (*.tgz) 

640-010-001-016 640-010-001-017 640-010-001-018 

5.0.0 
609-004-000-048 

 See note 2   

5.1.0 
609-004-000-049 

   

6.0.0 
609-004-000-050 

   

6.1.0 
609-004-000-051 

   

7.0.0 
609-010-000-001 

   

7.1.0 
609-010-000-001 

   

7.2.0 
609-010-000-001 

   

7.3.0 
609-010-000-001 

   

7.4.0 
609-010-000-001 

   

7.5.0 
609-010-000-001 

  See note 3  See note 4 

7.6.0 
609-010-000-001 

   

7.7.0 
609-010-000-001 

   
 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base-system and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in 
the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base-system, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 

3. For information on this version of VM600 XMx16 firmware, refer to the VibroSight 7.5 release notes.  
A firmware upgrade is required in order to run VibroSight 7.5.0 or later. 

4. For information on this version of VM600 XMx16 firmware, see 2.21 XMx16 + XIO16T module firmware.  
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw 
file name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Parker Meggitt (Meggitt SA) should also be stored in these directories. 

Table 8 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 9 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 10 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 8: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight software 
version 

Part number (PNR) 

642-002- 

000-011 

642-002- 

000-012 

642-002- 

000-013 

642-002- 

000-014 

642-002- 

000-015 

642-002- 

000-016 

5.1.0 
609-004-000-049 

See notes 

2 and 3 
See notes 

2 and 4 
 

   

6.0.0 
609-004-000-050 

  
    

6.1.0 
609-004-000-051 

  
See notes 

2 and 5 

   

7.0.0 
609-010-000-001 

   
   

7.1.0 
609-010-000-001 

   
See notes 

2 and 6 
  

7.2.0 
609-010-000-001 

      

7.3.0 
609-010-000-001 

      

7.4.0 
609-010-000-001 

      

7.5.0 
609-010-000-001 

      

7.6.0 
609-010-000-001 

    
See notes 

2 and 7 
See notes 

2 and 8 
7.7.0 

609-010-000-001 
      

 

Notes for Table 8 (see the next page)  
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Notes for Table 8 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

4. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

6. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 

7. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
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8. For information on this version of VibroSmart VSI010 firmware, see 2.22 VSI010 + VSB010 module firmware. 
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
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Table 9: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
Part number (PNR) 

642-004-000-011 642-004-000-012 642-004-000-013 

5.1.0 
609-004-000-049 

 See note 2 
  

6.0.0 
609-004-000-050 

 
  

6.1.0 
609-004-000-051 

 
  

7.0.0 
609-010-000-001 

 
  

7.1.0 
609-010-000-001 

 
See notes 

2 and 3 
 

7.2.0 
609-010-000-001 

   

7.3.0 
609-010-000-001 

   

7.4.0 
609-010-000-001 

   

7.5.0 
609-010-000-001 

   

7.6.0 
609-010-000-001 

  
See notes 

2 and 4 
7.7.0 

609-010-000-001 
   

 

Notes for Table 9 (see the next page)  
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Notes for Table 9 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. For information on this version of VibroSmart VSN010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 

4. For information on this version of VibroSmart VSN010 firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
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Table 10: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-001-000- 

000DEV_ 

SVN14937_ 

2020-05-20 

642-001-000-019 642-001-000-020 642-001-000-021 642-001-000-022 

5.1.0 
609-004-000-049 

See notes 

2 and 3 
 

   

6.0.0 
609-004-000-050 

 
    

6.1.0 
609-004-000-051 

 
See notes 

2 and 4 

   

7.0.0 
609-010-000-001 

  
   

7.1.0 
609-010-000-001 

  
See notes 

2 and 5 
  

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

7.4.0 
609-010-000-001 

     

7.5.0 
609-010-000-001 

   
See notes 

2 and 6 
 

7.6.0 
609-010-000-001 

    See notes 

2 and 7 
7.7.0 

609-010-000-001 
     

 

Notes for Table 10 (see the next page)  
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Notes for Table 10 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later. 

4. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

5. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 

6. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.5 release notes.  
A firmware upgrade is required in order to run VibroSight 7.5.0 or later. 

7. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600Mk2/VM600 and/or VibroSmart modules/devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600Mk2/VM600 and/or VibroSmart modules/devices 
firmware update may lead to incoherent system behaviour and affect the proper functioning of data acquisition in a 
system. It is only in systems where the firmware running on the VM600Mk2/VM600 and/or VibroSmart 
modules/devices already corresponds to the latest available version that no firmware update is required. Therefore, 
it is strongly recommended to verify the version of firmware running on the hardware before starting a VibroSight 
system upgrade, in order to establish if a firmware update is also required. 

NOTE: Updating the firmware for VM600Mk2/VM600 and/or VibroSmart modules/devices is 
a special task that can, if used unintentionally or incorrectly, lead to malfunctioning 
of the device and affect proper function of data acquisition. It is therefore strongly 
recommended to change the firmware of VibroSight-compatible hardware only 
when it is necessary. For example, when the devices must be updated to be 
compatible with a VibroSight software upgrade. 

During the firmware update of a device, the module or card being updated cannot 
provide its normal machinery monitoring functions because its outputs (alarms and 
relays) can go to undetermined states, irrespective of how they have been 
configured. 

 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 
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For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware 
(VM600Mk2/VM600 and/or VibroSmart modules/devices) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no VM600Mk2/VM600 and/or VibroSmart modules/devices in the tree structure or some are missing, 
verify your network connections. 

3. Select the module or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VM600Mk2/VM600 or VibroSmart modules/devices selected. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
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independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 
(VM600Mk2/VM600 modules/cards and /or VibroSmart modules) have been discovered and that data acquisition 
has resumed. 
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NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Parker Meggitt worldwide customer support network offers a range of support including Technical support and 
Sales and repairs support. For customer support, please contact your local Parker Meggitt representative. 
Alternatively, contact our main office: 

Customer support  
Parker Meggitt (Meggitt SA) 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Parker Meggitt technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

7.3 Sales and repairs support 

Parker Meggitt sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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Appendix 
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VibroSight software and Windows® operating system compatibility 

 

 
Windows 11 Windows 10 Windows 8.1 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

and extended support ended in 2023 

 

 

VibroSight software and Windows® Server operating system compatibility 

 

 
Windows Server 2022 Windows Server 2016 Windows Server 2012 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

and extended support ended in 2023 
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VibroSight software and Microsoft® .NET requirements 

VibroSight software version Microsoft .NET requirements 

VibroSight 7.6.x or later .NET 8.0 Desktop Runtime (v8.0.8) or later 

VibroSight 7.4.x or later .NET 7.0 SDK v7.0.306 or later 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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